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2. Overview  

WIS-NeuroMath is a software tool for automated quantification of neuronal morphologies 

in both in vivo and in vitro preparations. WIS-NeuroMath is based on accurate detection 

of candidate neurites using the algorithm described by Galun et al (2007). It first looks 

for edges in the image and then matches pairs of nearly parallel edges to find fibers, 

which constitute neurite-like structures. The method allows accurate detection of neurites 

in challenging images. Following neurite detection, three different types of processing 

can be carried out depending on the desired application:.  

 

Cell Morphology of cultured neurons 

Cell bodies are detected using the same image used for neurite detection. It then traces 

the candidate neurites to allow assignment to the relevant cell bodies. Neurite lengths, 

branching, cell body area and other parameters are then calculated and saved for each 

cell, while ignoring irrelevant items (neurites which are not attached to cell bodies, cell 

bodies that are too small or too big, etc.). Individual cell data are exported to Excel files, 

as well as image averages. The graphical user interface allows the user to modify 

detection thresholds and analysis parameters, to perform analyses on single files or whole 

directories, and to browse through the results. 

 

Neurite Length Analysis on Sections 

This mode provides a solution for images in which cell bodies are not present, for 

example longitudinal nerve sections that contain only neurites and non-neuronal cells. 

Neurites are detected and connected component analysis is applied to distinguish between 

neurite elements. A user-set threshold allows exclusion of very short neurite elements if 

desired, to reduce noise in certain experiments. The number of neurite elements, their 

average and median length are calculated as well as additional parameters such as the 

number of branches and the branching complexity. 
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Ganglion Explant Analysis 

Ganglion explant cultures represent a particular challenge since neurites can be very 

profuse and dense close to the ganglion, and even a human eye cannot distinguish 

between them. Hence, in this mode the user manually defines an ellipse mask around the 

ganglion. The software then detects neurites and counts the number of neurites crossing 

that mask. Neurite numbers can be calculated at several offsets inside and outside the 

mask, to provide average and median numbers of crossing neurites. The user can set 

numbers of offset masks and the distance between them as desired; hence this tool bears 

some resemblance to classical Sholl analyses of dendritic arbors.  
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3. Installation Instructions  

WIS-NeuroMath was compiled and tested under Windows XP and Windows 7. 

 

System Requirements  

Software requirements PC running Windows XP or Windows 7, either 32 or 64 bit. 

Matlab Run Time Component (MCR) 7.14  is required 

(provided at the website).  

Current Version 3.4.8 

License http://www.cs.weizmann.ac.il/~vision/NeuroMath/index.html  

 

Installation Steps  

This section describes how to install WIS-NeuroMath on a computer with the Windows 

XP operating system.  

 

1. Download WIS-NeuroMath onto your computer.  

2. Double-click on the zip file. Extract all the files into a new folder for example 

"C:\NeuroMath". Please make sure that there are no spaces in the target path. 

3. To run WIS-NeuroMath you must have Matlab Component Run Time (MCR) 7.14 

installed on your computer. To install it, download the appropriate MCRInstaller for 

your operating system from the WIS-NeuroMath download page, and run it. You 

should install the 32 bit or 64 bit versions depending on your computer. You must 

have administrator privileges to do it. MCRInstaller update the system path. In order 

for this update to work, you should logoff (or restart). 

4. To run WIS-NeuroMath, double click on either NeuroMath_32bit.exe or 

NeuroMath_64bit.exe under the bin subdirectory (for example click on 

C:\NeuroMath\bin\NeuroMath_32bit.exe). 

5. The Installation package includes different kinds of sample data, together with 

Preferences files suitable for those files. The samples files are in the data subdirectory 

while the preferences files are in the bin subdirectory. 

 

http://www.cs.weizmann.ac.il/~vision/NeuroMath/index.html
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4. Quick Start  

This section describes basic usage of WIS-NeuroMath with the Cell Morphology module. 

1. To run WIS-NeuroMath, double click on NeuroMath_32bit.exe (for example click on 

C:\NeuroMath\bin\NeuroMath_32bit.exe). The Main window will appear:  

 

Figure 1: WIS-NeuroMath Main Window 

2. To load an image, click the New Image button and select the image for analysis in the 

browse dialog opened. The Image will be shown in the Input Image panel. Its file 

name and path will appear underneath (see Figure 2). The software can handle tif and 

jpg files. 

3. To Process the Image, press the Run button.  

All buttons and menu items are disabled until processing is done. The status of the 

process is shown in the Status panel on the left side of the window. Processing time 

depends on the nature of the specific image and on the chosen parameters. In general 

analysis of images with more neurites takes longer. 
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Figure 2: Image Loaded 

4. When processing is complete the results are shown visually in the Results panel on 

the right side of the main window. You can toggle between different views of the 

results, using the radio buttons underneath the Results image (see Figure 3):  

- Cells: The detected cell bodies are shown with the neurites attached to them 

colored with the same color.  

- Candidate Neurites: All the candidate neurites found in the first stage are shown. 

- Rejected Neurites: Neurites which where not attached to cell bodies are shown. 

Usually these are neurites whose cell bodies are outside the border of the image. 

These neurites are not counted in all the cell and overall neurites length 

measurements. 

You can show cell labels by checking the Show Cell Labels checkbox. 

You can view the result in a separate window using the  button. 
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Figure 3: Display results 

 

Overall image measurements are shown in the Image Information table on the bottom left 

side of the window. Table 1 shows the full list of Image measures.  

Image Measure Name Description 

nTotalCells Number of detected cells 

CandidateLen Total length of candidate neurites 

ConfirmedLen Total length of neurites attached to cell bodies 

RejectedLen Total length of neurites not attached to cell 

bodies. 

%Rejected Percent of neurites not attached to any cell body. 

Usaully these are neurites whose cell body are 

outside the border of the image. Rarely there are 

also tracing errors, so watch this value as high 

value might indicate tracing errors. 

nSproutCells Number of cells for whom the length of the 

longest neurite exceeds MinNeuriteLength (see 

figure 4) 

%Sprouting Percent of sprouted cells out of the total detected 

cells 
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Image Measure Name Description 

AvgSCLen Average length of neurites attached to sprouted 

cells 

AvgTCArea Average area of all detected cell bodies 

AvgSCArea Average area of sprouted cells only 

LongestBranch Length of longest branch in the image 

AvgTCIntensity Average intensity all detected cell bodies 

AvgSCIntensity Average cell body intensity of sprouted cells only 

AvgSCNeuriteIntensity Average neurites intensity of sprouted cells only 

Table 1: Image Measures 

 

Per cell measurements are shown in the Cell Information table on the bottom right side of 

the window. Table 2 lists all the cell measures and their description. 

Cell Measure Name Description 

Area Cell area 

TotalConfirmed Total outgrowth, length of neurites attached to the cell 

nBranch Number of main neurites sprouting from the cell body. 

LongestBranchLen Length of the cell's longest branch 

Sprout? A flag indicating whether a cell is sprouted (1) or not (0) 

Cross? A flag indicating whether the neurites of this cell cross 

with those of another cell. In that case the tracing 

algorithm does not try to solve the ambiguity, but splits 

the neurite between the two cells at the point of equal 

distance from the two cell bodies. Thus in cases were 

there is a cross the total confirmed length might not be 

"correct" and the average values might be more suitable. 

CellIntensity Average intensity of the cell body, this can be used to 

measure protein expression level 

NeuriteIntensity Average intensity of the cell's neurites, this can be used to 

measure protein expression level. This is an 

approximation to the neurites' intensity that is based on 

the "skeletonized" neurites instead of the full width 

neurites. 

MajorAxis  Length of the major axis of the ellipse that has the same 

normalized second central moments as the region 

MinorAxis  Length of the minor axis of the ellipse that has the same 

normalized second central moments as the region 

AxialRatio  Major Axis / Minor Axis 

AvgLongestLength Each neurite pixel is assigned to specific branch 

(process). Thus we can measure the total outgrowth and 

longest process of each specific branch (Proc Len). 
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Cell Measure Name Description 

AvgLongestLength is the average length over all longest 

processes. 

MedianLongestLength Median length over all longest processes. 

MaxLongestLength  Maximum over all longest processes. 

MeanProcLen  Average length over all processes. 

MedianProcLen  Median length over all processes. 

MaxProcLen  Maximal length over all processes. 

Table 2: Cell Measures 

All the measurements are in the units (or squared units for area) defined in the Units 

panel (see Figure 4). In this panel the user should specify the scaling factor from image 

pixels to microns, which depends on the resolution and magnification used during the 

acquisition. The software converts pixels to microns to microns automatically and 

provides measurements in microns.  

 

5. Results are saved into two files: Averaged Results File includes one line for each 

Image with the content of Image Information table, and an additional line with 

average over all images (see batch processing). The Detailed Results File includes 

one line for each detected cell, in each processed image, with the content of Cell 

Information table. The files are placed under Dir\Output Suffix Dir\File Name. Their 

default names are set using Edit->Settings. They can be saved either in Excel format 

(.xls) or comma separated text file (.txt), and can be opened with Excel for example.  

6. To exit WIS-NeuroMath, click on the File menu on the upper right side of the 

window, and click the Exit item, or click the x on the upper right side of the window. 

 

Tip: If you want to check the effect of changing parameters, you can use different output 

file for each parameter set (Output Suffix Dir), and use Show Available Results button to 

check the results. 

 

5. Batch Processing 

WIS-NeuroMath provides two modes of operation: Single Image and Whole Directory. 

You switch between the modes using the radio buttons in the Input Image panel (see 

Figure 4). The modes differ in the following manner: 
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- Loading files: A file browser that let you select an image file is opened for Single 

Image mode. A directory browser that let you select a directory is opened in the 

Whole Directory mode. A list of all image files in the directory is created 

internally for further use. 

 

Figure 4: Batch Processing 

 

- In Whole Directory mode you can browse through the images in the directory 

using the Prev/Next buttons. These buttons are disabled in Single Image mode. 

- You can view results of previous runs by clicking the Show Available Results 

button. A message box will appear if no results are available. Just click OK to 

close it (and click Run if you want to process the image). If you click Show 

Available Results in Whole Directory mode, then browsing the images using the 

arrow buttons will browse through the results as well. If results are not available 

for an image a message box will appear. If you want to browse only the original 
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images and not the results click the Clear Results Pane button. This will clear 

only the display and will not erase any existing results. 

- Run: in Whole Directory mode clicking the Run button, will process all the 

images in the directory. This is very useful for processing many files. You can 

browse through the images using Whole Directory mode, and switch to Single 

Image when you find the image you were looking for, to process only this image.  

- Stop: in Whole Directory mode you can stop the batch processing of images by 

clicking the Stop button. The processing will not stop immediately but when 

processing of the current image is done.  

 

The results files are replaced each time you click the Run button, however, per image 

temporary files of images which are not involved in the current Run are not removed. 

 

6. Neurite Detection  

Neurite detection is the basis for all the quantification done by WIS-NeuroMath.  

Neurites detection is done using an algorithm which first looks for Edges in the image 

and then matches pairs of nearly parallel edges to find Fibers, which constitute the 

neurites. It was developed using florescent images in which the neurites are bright on a 

dark background. However, one can choose to look for dark fibers on a bright 

background.  

The following section describes the role of the different parameters in the above process. 

The tool enables you to adjust them according to your image requirements. A detailed 

description may be found in the references listed. Note that for getting started the default 

parameters or those in the provided preferences files (see Preferences and Settings below) 

are usually sufficient and no changes are necessary for most of them.  

Some neurite detection parameters are set through the main window, while most of them 

are set through the Advanced Parameters window. 

During Parameter tuning, you can work only on neurite detection without quantification 

by setting the Measure Type to None (see Figure 5). When you are satisfied with the 

neurites detection, you can use the current neurites and tune the quantification parameters 
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only by selecting the proper Measure Type in the main window setting Edge/Fibers to 

None in the Advanced Parameters window (see  

Figure 6). You should remember to set it back to fibers when you want to run it from the 

beginning. 

 

Main Window  

 

Figure 5: Setting Neurite Parameter 

 

Sensitivity of neurite detection is controlled by the Noise Level parameter. Noise Level 

can be fixed for all the images or different for each image.  

Noise Level is a threshold that controls the edge detection stage of the algorithm. It’s 

typical values should be in the range of 2-6 for 8 bit florescent images. You should 

consider changing this value in cases such as:  

 - The image contains low intensity neurites which are not recognized by the 

default parameters. Try lowering the value to ~2. 
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 - The candidate neurites results include many small isolated parts ("noise"). Try 

using higher values (5-6). 

You can calculate the Noise level of the image using the Calculate button. This 

calculation is controlled by the Noise Level Percentile parameter in the Advanced 

Parameters Window (reasonable values are at 0.7-0.9 range).  

You can choose to work with a fixed threshold for all the images or with automatically 

calculated threshold specific to each image by checking the Auto Calc Noise checkbox.  

Please note that in general analysis with lower values takes longer.  

 

Advanced Parameters Window 

To edit advanced parameters, click the Edit menu (see Figure 5) and then the Advanced 

Parameters item. The Advanced Parameters window will appear (see  

Figure 6). 

This set of parameters is used to control advanced behavior of the underlying algorithms.  

Description of some parameters in this window is beyond the scope of this User Guide.  

 

Neurite Detection is done in the following steps: 

- Multi scale edge detection 

- Matching parallel edges to form Enhanced Fibers picture 

- Setting a threshold on the Enhanced Fibers to select the whole neurites (Binary 

Fibers). 

- Thinning the binary fibers to get their skeleton (1-pixel width lines), which are the 

candidate Neurites. 

 

Usually only the final candidate neurites picture is saved. You can see intermediate 

results by selecting the Save Edges Picture, Save Enhanced Fibers Picture and Save 

Binary Files Picture. This may be useful while tuning parameters, but should be set off 

when running on many files as it take considerable disk space. 
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Edge Detection Parameters 

Sensitivity of the Edge Detection is controlled by Noise Level that was described above 

and by the following other parameters: 

 

Mask Width – defines the width of the mask around the edge that is used for edge 

detection. A mask of 3 pixels compares the intensity values of 1 pixel from each side of 

the examined pixel. A mask of 5 pixels compares the intensity values of 2 pixels from 

each side of tested pixel, while a mask of 7 compares 3 pixels from each side of tested 

pixel. Usually a mask of 3 pixels is sufficient, use wider masks for noisier images. 

Edge detection is done using a multi-scale algorithm which builds long straight edges 

from shorter ones. Up to 7 levels (2
6
 = 64 pixels in strait lines) can be used but usually 

for biological data where the neurites are curved the 4 (8 pixels) or 5 (16 pixels) levels 

are sufficient. Max Level controls the number of levels used.  
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Figure 6: Advanced Parameters Window 

The Tolerance parameter let you accept broken edges. Its value is between 0-1, and it 

defines the length of maximal allowed percent of gaps within an edge. A value of 0 does 

not allow gaps, while a value of 0.375 allows a gap of up to 3/8 of the edge. 

 

Fiber Detection Parameters 

When working with florescent images neurites are bright on a dark background. For 

other application you may look for fibers which are dark on a bright background.  
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Fibers are detected by matching parallel edges using a kernel of width Kernel Width and 

height of Kernel Sigma. These two parameters control the distance between the parallel 

edges (in pixel units for Kernel Width). Use higher values of Kernel Width to allow 

detection of wider neurites. However this should be done with caution as selecting too 

big Kernel Width may cause two close neurites to be detected as one neurite. 

 

Enhanced Neurites Thr is the threshold used for conversion between the enhanced Fibers 

picture to the Binary picture. Lower values enable detection of harder to find Neurites. 

Note that choosing too low values might result in "Noisy" results. 

 

7. Cell Morphology 

The same image serves to identify both neurites and neuronal cell bodies, the latter 

detected using simple threshold based segmentation 

The following parameters control the Cell Morphology module: 

 

Min Cell Intensity: A minimum threshold value for cell body intensity. This value is used 

for cell bodies detection. Only areas with higher intensity are considered as cell body 

candidates. Thus unfocused cells and non-florescent cells are ignored. You can use Pixel 

Info for measuring cell intensity (see chapter ‎12). 

Min Area: is a minimum threshold value for cell body area. Smaller cell bodies are 

ignored during the analysis. This is used in order to discard small particles which are not 

really cell bodies. 

Max Area is a maximum threshold value for cell body area. Larger cell bodies are 

ignored during the analysis. This is used in order to reject cell aggregates during the 

analysis of the image. 

Min Diameter is a minimum threshold value for cell body diameter (assuming the cell is 

round). This is another mean (in addition to MinArea) to reject small cell-body-like 

particles. You can use the Distance tool for measuring cell diameter (see chapter ‎12). 

Min Neurites Length controls the "sprouting" decision. Cell bodies whose longest neurite 

is longer than this value are declared "sprouted" for further overall averaging. Cells with 
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lower values are declared "non-Sprouted" and are not taken into account for calculating 

"Average Sprout Cell Area", and "Average Neurites Length Per Sprout Cells".  

 

 

Figure 7: Cell Morphology Parameters 

 

Neurite Dist from Cell Body (from the Advanced Parameters window) controls the 

process of attaching neurites to cell bodies. It defines the maximal distance (in pixels) of 

the neurite from the cell body. This is done in order to overcome short gaps that cause 

neurites not to be attached to the cell body. You might want to enlarge its value if you 

have neurites which were not attached to their cell body.  

Measurement Unit: Can be either Pixel, mm or um (the default). This is the measurement 

units used for all results reporting, and the units of the cell body parameters.  

Unit to Pixel conversion: Number of pixels for each measurement unit. Set this value 

according to your microscope & experimental setup. 
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8. Neurite Length Analysis 

 

Figure 8: Neurite Length Parameters 

This module of provides a solution for images in which cell bodies are not present, for 

example longitudinal nerve sections that contain only neurites and non-neuronal cells. 

Neurites are detected and connected component analysis is applied to distinguish between 

neurite elements. Min Neurite Length is a threshold which allows exclusion of very short 

neurite elements if desired, to reduce noise detection in certain experiments.  

By default each connected component is shown in different color. You can show all the 

neurites in one color by checking the Use One Color checkbox. 

 

The following table shows the specific measures of this module. They are shown in the 

Image Information Table. 
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Parameter Name Description 

nFiberElements Number of distinct neurite elements 

AvgFiberElementLength Average length of neurite elements 

MedianFiberElementLength Median length of neurite elements (50
th

 percentile) 

Prctl70FiberElementLength 70
th

 percentile‎of‎neurite‎elements’‎length‎ 

Prctl80FiberElementLength 80
th

 percentile‎of‎neurite‎elements’‎length 

Prctl90FiberElementLength 90
th

 percentile‎of‎neurite‎elements’‎length 

nTotalBranchPoints Number of branching points in all candidate neurites 

nConfirmedBranchPoints Number of branching points in confirmed neurites 

BranchingComplexity number of confirmed branches / confirmed neurite length 

Table 3: Neurite Length Measures 

 

9. Ganglion Explant Analysis  

Neurite Count 

 

In this mode the user manually defines an ellipse mask around the ganglion, the software 

detects neurites and counts the number of neurites crossing that mask. The software can 

count neurite numbers at several offsets inside and outside the mask, to provide average 

and median numbers of crossing neurites. The user can set numbers of offset masks and 

the distance between them as desired using the Number of Offsets and In/Out Masks 

Offset fields (see Figure 9). 

 

Use the  button to define a mask. You can do this either in the main window or in a 

separate window (use the  button). To‎save‎the‎mask‎click‎the‎mouse’‎right‎button. A 

context menu will be shown which let you delete or save the mask. The masks are saved 

into Masks Sub Directory, the name of the mask is set the file name with extension 

defined by Mask File Suffix.  These values can be set using the Settings window (see 

Figure 10), which let you also set other default properties of the Mask.  
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Figure 9: Neurite Count Setting 

 

Once the mask is set you can run the analysis. You can set all the masks in advance and 

then run the quantification in a batch mode. The following calculated measures are shown 

in Cell Information table and written into the Detailed Results File includes. The Image 

Information table is not relevant for this module. 

Parameter Name Description 

AvgNBranch Average number of crossing neurites over all masks 

MedianNBranch Median number of crossing neurites over all masks 

nBranch Number of neurite crossing the defined mask 

nBranchIn1 Number of neurite crossing the 1 offset inside the defined mask 

nBranchOut1 Number of neurite crossing the 1 offset outside the defined mask 

nBranchIn2 Number of neurite crossing the 2 offsets inside the defined mask 

nBranchOut2 Number of neurite crossing the 2 offsets outside the defined mask 

….  

Table 4: Neurite Count Measures 
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Total Outgrowth 

 

In order to get total outgrowth parameter use cell morphology mode. However, as the 

explant intensity varies a lot, you should define the explants “borders” manually using a 

mask.  

Choose Mask instead of Threshold for the Segmentation Type in the Cell Parameters 

panel.  

Use the  button to define a mask. You can do this either in the main window or in a 

separate window (use the  button). To‎save‎the‎mask‎click‎the‎mouse’‎right‎button. A 

context menu will be shown which let you delete or save the mask. The masks are saved 

into Masks Sub Directory, the name of the mask is set the file name with extension 

defined by Mask File Suffix.  These values can be set using the Settings window (see 

Figure 10), which let you also set other default properties of the Mask. If you are using 

both total outgrowth and neurites count on the same image, use different Mask File Suffix 

for each of them. 

Once the mask is set you can run the analysis. You can set all the masks in advance and 

then run the quantification in a batch mode. Overall image measurements are shown in 

the Image Information table on the bottom left side of the window, as detailed in the 

Quick Start section. 

 

 

10. Preferences and Settings 

 

The Settings window allows you to control some additional application settings. Choose 

Settings from the Edit menu to set default Image Location, Results File names and format 

and color to grayscale conversion scheme (see Figure 10).  

 

You can save all parameters and settings into preferences file, which can be loaded later 

on. Typically it is useful to have different preferences file for each experimental setup.  

Use Load Preferences and Save Preferences from the File menu for this.  
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Figure 10: Settings Window 

 

You can get back to the default parameter setting by choosing Restore Default 

Parameters from the File menu.  

 

Choose Restore Run Parameters from the File menu to view and set the WIS NeuroMath 

parameters to the parameters used in the last run (in a given directory). 

 

11. Working with high resolution images 

High resolution (up to 16bit per pixel) images are supported. You can control the 

displayed range either using the Adjust Intensity checkbox and %Outlier value or by 

clicking Adjust Contrast button . A new window will open that will allow you to 

change the displayed data range. The easiest way is to use the mouse to drag the red lines 

to the desired value. The image is updated on the screen as you do it. 
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Figure 11: Adjust Contrast 

Note that the current default parameters are set for low resolution images.  

Set Min Cell Intensity value to proper value (e.g. 2500). You can use the Pixel Info tool 

for this (see chapter ‎12). 

You might also want to change Noise Level to higher value (e.g. 8-10), but this depends 

on the image. 
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12. Measurement Tools 

Several measurement tools and utilities are provided: 

 

Figure 12: Measurement Tools 

Intensity Measure 

When you move the mouse in the original image area, the pixel value at the current 

mouse location is shown in the Pixel Info field, just underneath the image. This is very 

useful for setting the Min Cell Intensity value.  Intensity measure is more accurate in the 

separate window.  

Distance Tool 

To measure cell diameter click on the Distance Tool icon . This will create a Distance 

Tool on the original image. 

The Distance tool is a draggable, resizable line, superimposed on the image that measures 

the distance between the two endpoints of the line. Using the mouse, you can move and 

resize the Distance tool to measure the distance between any two points in an image. The 
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Distance tool displays the distance in a text label superimposed over the line. The tool 

specifies the distance in the units defined in the Units panel. Figure 12 shows a Distance 

tool on the original image. You can move the Distance tool over an image by dragging it 

with the mouse. You can also resize the Distance tool by selecting one of the endpoints 

with the mouse and dragging the endpoint. 

 

The Distance tool has a context menu associated with it that allows you to  

- Toggle the distance label on/off 

- Specify horizontal and vertical drag constraints 

- Delete the Distance tool object 

Right-click to access the Distance tool context menu. 

 

Zoom-In 

To view the image in a separate window, which you can resize easily, click the Separate 

Figure icon .  Distance tool, Adjust Contrast and Pixel Info are provided for the 

separate figure as well. 

 

Color images  

True color images are automatically converted to grayscale, as all the processing is done 

on grayscale images. You can choose the conversion scheme using the Setting window.  
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13. Miscellaneous  

Images bigger than about 800*800 pixels are automatically resized. If resize is done the 

resized image can be shown in the Results panel (above candidate neurites). The user 

should make sure that the neurites are well recognized by eye in the resized image. In 

general it is not recommended to use images that require resize factors over 3-4. On the 

other hand NeuroMath handles is more suited for detection of thin neurites (3-10 pixels 

wide). The user can adjust the neurite width by changing the Neurite Fiber parameters in 

the Advanced parameters window. However when working with large magnification 

where the neurites are much wider resizing the image can improve the performance. 

 

Temporary result files are created in the tmp sub folder of output directory. This includes 

all the visual results and can take considerable disk space. If you no longer want the 

visual results, you can safely remove all files in the tmp sub folder, but make sure not to 

remove AvgResults.txt and CellResults.txt which contains the summary of results if you 

need them.  

 

The results files are either Excel files (.xls) or comma separated files (.txt). To open 

comma separated files in Excel, Click File →‎Open from the Excel's main menu. In the 

dialog box go to the relevant folder, choose All Files (*.*) in the Files of type field to see 

the text files. A Text Import Wizard will open, choose the delimited radio button. And 

click the Next button. Choose Comma in the Delimiters panel and click Finish. 
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